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General Knowledge
1.	 On the bank of now dry course of which 

river, the ancient city of Harappa was 
built?

		  (A)	 Yamuna	 (B)	 Gandak
		  (C)	 Kosi	 (D)	Ravi

2.	 Which of the following rivers is named 
only once is Rigveda ?

		  (A)	 Ganga	 (B)	 Indus
		  (C)	 Jhelum	 (D)	Saraswati

3.	 In all the attacks of Mahmud Ghaznavi 
(between 1000 AD to 1026 AD), which 
was the most important attack?

         (A)	 Invasion of Multan Bathinda (1004)
         (B)	 Attack on Narayanpur (1002)
         (C)	 Invasion of Somnath Temple (1025-

26)
         (D)	 Invasion of Kalinjar (1019-23)

4.	 Captain Hawkins visited India during 
the reign of :

		  (A)	 Babur	 (B)	 Shahjahan
		  (C)	 Jahangir	 (D)	 Akbar

5.	 Khudai Khidmatgar, a voluntary organ-
isation, was established by which of the 
following leaders of India?

		  (A)	 Muhammad Ali Jinnah
		  (B)	 Maulana Muhammad Ali
	 	 (C)	 Khan Abdul Ghaffar Khan 
		  (D)	 Hakim Ajmal Khan

6.	 Mohiniyattam is a classical dance form 
of which state ?

		  (A)	 Assam	 (B)	 Karnataka
		  (C)	 Kerala	 (D)	Tamil Nadu

7.	 Which of the following state does not 
share its boundary with China ?

		  (A)	 Arunachal Pradesh
		  (B)	 Himachal Pradesh
		  (C)	 West Bengal
		  (D)	 Uttarakhand

8.	 Central Salt and Marine Chemicals 
Research Institute is located in ........... .

		  (A)	 Punjab	 (B)	 Chhattisgarh
		  (C)	 Uttarakhand	 (D)	Gujarat

9.	 Select from the following, which is the 
hottest planet in the Solar System ?

		  (A)	 Mars	 (B)	 Venus
		  (C)	 Mercury	 (D)	 Jupiter

10.	 Ecology is the study of :
		  (A)	 bird
		  (B)	 formation of cell
		  (C)	 Study of relationship between living 

beings and environment
		  (D)	 tissue
11.	 Which one among the following state-

ments regarding the Government of India 
Act, 1935 is not correct ?

		  (A)	 Provincial Autonomy came into 
existence

		  (B)	 Bicameral legislatures were provided 
in six provinces

		  (C)	 The principles of communal elect-
rorates and weightages were further 
extended

		  (D)	 The states were compelled to enter 
the Federation

12.	 Match List-I with List-II and select the 
correct answer using the code given 
below the Lists :

			   List-I		  List-II
		  (Amendment to the	 (Subject)
		  Constitution of India)
		  a. 	52nd Amendment	 1.	Reduction of 
			   Act, 1985		  voting age 	

		  from 21 to 18
		  b. 	73rd Amendment	 2.	Right to 		

Act, 1992		  Education
		  c. 	61st Amendment	 3.	Panchayati 	

Act, 1988		  Raj
		  d. 	86th Amendment	 4.	Disqualifica-
			   Act, 2006		  tion on 		

		  grounds of 	
		  defection

		  Codes :
			   a	 b	 c	 d
		  (A)	 4	 1	 3	 2
		  (B)	 4	 3	 1	 2
		  (C)	 2	 3	 1	 4
		  (D)	 2	 1	 3	 4
13.	 Which one of the following statements 

regarding the objectives of the Second 
Five-Year Plan is not correct?

		  (A)	 Development of the basic and heavy 
industry sector

		  (B)	 Increase in national income to raise 
living standards

		  (C)	 Expansion of the consumer goods 
sector

		  (D)	 Expansion of employment opportu-
nities

14.	 Name the first Indian woman to be 
conferred with Grammy Award.

		  (A)	 Tanvi Shah
	 	 (B)	 Anushka Shankar
		  (C)	 Asha Bhosle	
	 	 (D)	 Ananya Birla
15.	 Global Competitiveness Report is issued 

by which of the following organization?
		  (A)	 WTO	 (B)	 WEF
		  (C)	 SAARC	 (D)	EU
16.	 The SI unit for measuring very large 

distances] such as astronomical distances] 
is________ -

		  (A)	 astronomical unit
		  (B)	 light year
		  (C)	 kilometre
		  (D)	 metre
17.	 What is the full form of CNG?
		  (A)	 Carbonated Natural Gas
		  (B)	 Combustible Nitrogen Gas
		  (C)	 Compressed Natural Gas
		  (D)	 Chemical Natural Gas
18.	 Which of the following metals is most 

ductile?
		  (A)	 Lithium	 (B)	 Sodium
		  (C)	 Lead	 (D)	 Gold
19.	 Which of the following is an example of 

a unicellular organism?
	 	 (A)	 House fly	 (B)	 Hydra
		  (C)	 Amoeba	 (D)	 Lizard
20.	 Select the INCORRECT pair related to 

digestive glands and their enzymes.
		  (A)	 Pancreas - pancreatic juice
		  (B)	 Liver-bile juice
		  (C)	 Salivary gland - trypsin

		  (D)	 Gastric gland - pepsin

Basic Computer Literacy
21.	 The process that loads the operating 

system installed on your computer into 
the main memory or Random Access 
Memory (RAM) is called :

Practice Set-1
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		  (A)	 Index	 (B)	 Format
		  (C)	 Boot	 (D)	Map
22.	 In microprocessor 8085, which of the 

following is a 16-bit register?
		  (A)	 Flag register	 (B)	 Stack pointer
		  (C)	 W register	 (D)	 Z register
23.	 What is the full form of PCB?
		  (A)	 Printed Control Board
		  (B)	 Picture Control Board
		  (C)	 Picture Circuit Board
		  (D)	 Printed Circuit Board
24.	 Select the most appropriate options to fill 

in the blanks.
		  Microprocessor 8085 has ____ address 

line, hence, it can access _______ of the 
memory.

		  (A)	 16; 64 kilobytes
		  (B)	 16; 32 kilobytes
		  (C)	 8; 32 kilobytes
		  (D)	 8; 64 kilobytes
25.	 Tamper Protection is a feature that 

prevents unauthorised apps from changing 
your security settings. Which of the 
following Operating Systems supports 
the same?

	 	 (A)	 Windows 10	 (B)	 Windows XP
	 	 (C)	 Linux	 (D)	Windows Vista
26.	 Which of the following option is NOT 

used to perform the next animation or 
advance to the next slide in MS Power 
Point?

		  (A)	 Enter	 (B)	 N
		  (C)	 Shift+F5	 (D)	 Page Down 
27.	 What is the purpose of the 'Subject line' 

in an email?
		  (A)	 To give a brief summary of the 

email's topic
		  (B)	 To list the recipients of the email
		  (C)	 To include attachments with the 

email
		  (D)	 To provide a detailed explanation of 

the email content
28.	 Microprocessor as a switching device is 

for which generation of computer?
		  (A)	 First generation
		  (B)	 Second generation
		  (C)	 Third generation
		  (D)	 Fourth generation
29.	 In a computer, the archive deleted file 

is called?
		  (A)	 Desktop	 (B)	 Recycle Bin
		  (C)	 My Computer	 (D)	Control Panel
30.	 A markup language and file format 

used for storing, transmitting and 
reconstructing arbitrary data is known 
as ............... .

		  (A)	 HTML	 (B)	 XML
		  (C)	 EML	 (D)	SGML
31.	 Who created FORTRAN–the first high-

level computer programming language ?
		  (A)	 Larry Ellison
		  (B)	 Marc Andreessen
		  (C)	 John Backus
		  (D)	 Dan Bricklin
32.	 Which of the following pairs is not 

correct?
		  I.   Touch Pad – Locator Device
		  II.  Microphone – output device
		  III. Monitor – output device
		  (A) I and II	 (B) I and III
		  (C) II only	 (D) all of the above
33.	 Which shortcut key is used to paste a slide 

in Microsoft PowerPoint ?
		  (A)	 Ctrl + C	 (B)	 Ctrl + X
		  (C)	 Ctrl + V	 (D)	Ctrl + P
34.	 Which of the following is the best quality 

graphics printer ?
(A)	 Laser Printer
(B)	 Plotter
(C)	 Ink Jet Printer
(D)	 Dot Matrix Printer

35.	 ________ in Analog Computer.
(A)	 Input is never converted into digital 

form.
(B)	 The input is first converted into 

digital form. 
(C)	 The output is displayed in digital 

form.
(D)	 All of the above.

36.	 Which of the following commands is used 
to compare files ?
(A)	 Du	 (B)	 Cmp
(C)	 Cp	 (D)	 Comp

37.	 Which of the following is used to hide 
icons on the Desktop ?
(A)	 Desktop Icons Disappear
(B)	 Hidden
(C)	 Hide Shortcut
(D)	 Hide Icon

38.	 Which of the following shortcut keys is 
used to exit a document in Libreoffice ?
(A) Ctrl + l	 (B) Ctrl + w
(C) Ctrl + q	 (D) Ctrl + r

39.	 Which of the following menu option is used 
to launch 'Spell Checker' in Libreoffice 
Writer ?
(A)	 Tools > Automatic Spell Checking
(B)	 Format > Automatic Spell Checking
(C)	 Format > Spell Checking
(D)	 Tools > Spell Checking

40.	 What is displayed in the name box of 
Libreoffice Calc ?
(A) Column Name	 (B) Cell Address
(C) Sheet Name	 (D) None

Numeric Ability

41.	 Which of the following pairs in NOT a 
pair of twin primes?

		  (A)	 71, 73	 (B)	 131, 133
		  (C)	 191, 193	 (D)	11, 13
42.	 What is the digit at the unit place  

(98)68 × (55)62 × (27)91?
		  (A)	 0	 (B)	 6
		  (C)	 2	 (D)	5
43.	 If the least common multiple of 85 and 

255 can be expressed as 85R + 255, then 
the value of R is :

		  (A)	 0	 (B)	 10
		  (C)	 6	 (D)	 14

44.	 If X = 
1

1 2

1

2 3

1

3 4×
+

×
+

×  + ... + (10 

terms) and Y = 
1

4 5

1

5 6

1

6 7

1

7 8×
+

×
+

×
+

×
 

1

4 5

1

5 6

1

6 7

1

7 8×
+

×
+

×
+

×
+ ....+ (10 terms) then find the 

average of X and Y?

		 (A)	
533

616 	 (B)	
353

616

		 (C)	
435

616
	 (D)	

335

616

45.	 	 The average weight of the students in a 
class is 49 kg. 5 more students have joined 
the class whose weights are 45 kg, 46.8 
kg, 47.4 kg, 54.2 kg and 63.6 kg. Now 
the average weight of all the students in 
the class becomes 50 kg. What was the 
number of students in the class initially ?
(A)	 7	 (B)	 8
(C)	 10	 (D)	 12

46.	 There are two classes A and B having a 
fixed number of students. If 5 students 
are transferred from A to B, then the 
number of students in B becomes twice 
the number of students in A. If 1 student is 
transferred from B to A, then the number 
of students in both the classes becomes 
equal. How many students are there in B?

		  (A)	 17	 (B)	 22
		  (C)	 26	 (D)	 19
47.	 	 The number ‘a’ is inversely proportional 

to ‘e’, when a = 50, e = 22. Find the 
equation relating ‘a’ and ‘e’.

(A)
	

a
e

=
1100

	
(B)	 e = 11a

(C)	 a = 13e
	

(D)
	

a
e

=
1213

48.	 The sum of two times Manavi's present 
age and Tanvi's present age is 35 years. 
Tanvi's father is presently three times as 
old as Tanvi. Manavi's brother's present 
age is 6 years more than Manavi's present 
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age. The sum of the present ages of 
Tanvi's father and Manavi's brother is 56 
years. What is the sum of the present ages 
(in years) of Manavi and Tanvi ?

		  (A)	 27	 (B)	 31

		  (C)	 23	 (D)	24
49.	 If the price of a commodity is increased by 

36%, by what percentage (rounded off to 
1 decimal place) should its consumption 
be decreased so that the expenditure of 
the commodity stays the same ?

	 	 (A)	 32%	 (B)	 29.5%
	 	 (C)	 36%	 (D)	26.5%
50.	 If the length of a rectangle is increased 

by 70%, then by what percentage will its 
width be reduced to maintain the same 
area (Nearest approximate integer)  

		  (A)	 61%	 (B)	 60%
		  (C)	 42%	 (D)	 58%
51.	 A sold a table to B at a profit of 40%, B 

sold it to D at a profit of 60%. W sold a 
chair L to X at the loss of 20%, X sold it 
to P at a loss of 30% and finally P sold it 
to G at a loss of 50%. Price at which D 
bought the table from B and the price at 
which P bought the chair from X is same. 
If the price at which W bought the chair 
is ` 600, then at what price D bought  
table?

		  (A)	 ` 336	 (B)	` 396
		  (C)	 ` 219	 (D)	` 348

52.	 	 By selling an article at 9
11

 of its selling 

price, Madhu incurs a loss of 10%. If 
she sells the article at 95% of its actual 
selling price, then what will be the profit 
percentage (correct to one decimal place)?
(A)	 5.4%	 (B)	 4.5%
(C)	 6.8%	 (D)	 3.8%

53.	 X and Y are two alloys of Gold and 
Platinum prepared by mixing the metals 
in the ratio of 5 : 2 and 5 : 7, respectively. 
If we melt equal quantities of the alloys 
to from a third alloy Z, then the ratio of 
the quantity of Gold to the quantity of 
Platinum in Z will be :

		  (A)	 84 : 73	 (B)	 73 : 95
		  (C)	 95 : 73	 (D)	95 : 84
54.	 Arihant starts a certain work. After 4 days, 

Arun, who is half as efficient as Arihant, 
starts working on the same work. As a 
result, the work is completed in 9 days if 
Arun works alone to complete the work, 
how long will it take?

		  (A)	 35 days	 (B)	 38 days

		  (C)	 39 days	 (D)	32 days
55.	 An amount of ` 8,000 was invested for 2 

years, partly in scheme 1 at the rate of 5% 
simple interest per annum and the rest in 
scheme 2 at the rate of 4% simple interest 

per annum. The total interest received at 
the end was ̀  720. The amount of money 
invested in scheme 1 is :

	 	 (A)	 ` 4,400	 (B)	 ` 7,200
	 	 (C)	 ` 3,640	 (D)	` 4,000
56.	 The distance between two stations, Delhi 

and Amritsar is 450 km. A train starts at 
4 p.m. from Delhi and moves towards 
Amritsar at an average speed of 60 km/h. 
Another train starts from a Amritsar at 
3 : 20 p.m. and moves towards Delhi at 
an average speed of 80 km/h. At what 
distance from Delhi will the two trains 
meet ?

		  (A)	 160 km	 (B)	 180 km
		  (C)	 170 km	 (D)	165 km
57.	 The pie chart given below shows the 

number of fridge sold by 6 different 
companies. The total number of fridge 
sold by all these 6 companies is 7200. 
Number of fridge sold by a particular 
companies is shown in term of degree 
with respect to the total number of fridge 
sold by all these 6 companies.

P
80º

U
30ºT

25º
S

15º

R
140º

Q
70º

J1 = The average number of fridge sold 
by R, S and T.
J2 = The sum of average number of sold 
by P and Q and the average number of 
fridge sold by S and U.
What is the value of (J2 – J1)?

		  (A)	 650	 (B)	 750
		  (C)	 450	 (D)	675
58.	 The table given below shows the 

production of 6 companies in three years. 

Company
Year

Y1 Y2 Y3

C1 20 40 80
C2 30 20 70
C3 50 72 48
C4 40 60 16
C5 60 50 24
C6 26 90 36

What is the ratio of the total production 
of company C1 to the total production of 
company C2 in all the 3 years?

		  (A)	 12 : 7	 (B)	 9 : 7
		  (C)	 7 : 3	 (D)	7 : 6
59.	 Following graph shows new users joined 

and users dropped for some cell phone 

companies. If total of new users joined 
company C are 54000 then find the new 
users joined to company A.

		  		
		  (A)	 80000	 (B)	 85000
		  (C)	 95000	 (D)	90000
60.	 The given pie chart shows the number of 

bulbs produced by a company in 6 years. 
The number of bulbs produced in a year is 
expressed as a percentage of the number 
of bulbs produced in all the years.

		

Y1,

10%

Y2,

20%

Y3,

30%

Y4,

10%

Y5,

14%

Y6,

16%

If the total number of bulbs manufactured 
in 6 years is 100000, then what is 
the difference in the number of bulbs 
manufactured in year Y3 and Y5?

		  (A)	 11000	 (B)	10000

		  (C)	 13000	 (D)	16000

General Reasoning
61.		 Arrange the given words in the sequence 

in which they occur in the dictionary.
		  (1)	 Cardiodynias	 (2)	 Cardiospasms
	 	 (3)	 Carburetting	 (4)	 Carburettors
		  (5)	 Carcinogenic
		  (A)	 34512	 (B)	 43512
		  (C)	 34521	 (D)	43521
62.	 In a certain code language if BUCKING-

HAM is coded as 79, TRANSFORMER 
is coded as 136, this how will MASSA-
CHUSETTS be coded? 

		  (A)	 163	 (B)	 165
		  (C)	 153	 (D)	155
63.		 In the following question, a group of 

letters is given. The letters of each group 
are related with the letters of the same 
group by some Logic/ Rules/Relation. 
From the given alternatives, select a group 
of letters which follows the same Logic/
Rule/ Relation.

		  		(VM, WN, XO)
		  (A)	 (JN, LO, MP)	 (B)	 (AD, BE, CG)
		  (C)	 (ST, TU, UV)	 (D)	 (EP, DQ, CR)
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64.		 Four letter clusters are given out of which 
the three letter clusters bear a certain 
common relationship. Choose the option 
in which the letter clusters are differently 
related.

		  (A)	 EIMQ	 (B)	 DHLP
		  (C)	 EJNS	 (D)	TXBF

65.		 How many 3's are immediately preceded 
by 9 but not immediately followed by 5 
in the following number series ?

	 	 9 3 4 5 9 3 5 9 3  6 4 3 9 3 3 5 3 9 9 5 3 9 
3 7 5 7 5 9 3 9 5 

		  (A)	 4 	 (B)	 3
	 	 (C)	 5	 (D)	2

66.		 In a family of eight persons, there are 
two couples each having two childrens. 
B and D are brothers and each has two 
childrens. E is the aunt of A, who is the 
cousin brother of C. C is the sister of H. 
Who is the cousin brother of G. F is the 
wife of B. How is H related to F ? 

		  (A)	 Brother-in-law	(B)	 Nephew
		  (C)	 Son-in-law	 (D)	Son
67.		 A series is given with one term missing. 

Select the correct alternative from given 
ones will complete the series.

		  	BSWG, CTXE, DUYC, ?, EWAY
		  (A)	 ZVEA	 (B)	 EVZA
		  (C)	 AAZV	 (D)	VEAZ
68.		 Which of the following numbers will 

replace the question mark (?) in the given 
series ?

		  	46, 54, 70, 102, 166, ?
		  (A)	 290	 (B)	 305
		  (C)	 294	 (D)	314
69.		 If I denotes ‘÷’, J denotes ‘×’, K denotes 

‘–’, and L denotes ‘+’ then what will come 
in place of ‘?’ in the following equation ?

		  29 J 7 K 1 68 I 4 L 7 1 K 39 L 1 4 J 2 =  ?
		  (A)	 221	 (B)	 216
		  (C)	 228	 (D)	235
70.		 Two different positions of the same 

dice are shown having numbers 1 to 6 
represented as dots. Find the number on 
the face opposite the face showing '2'

		   	
		  (A)	 4	 (B)	 3
		  (C)	 1	 (D)	5
71.		 Select the venn diagram that best 

represents the relationship between the 
following classes. And select the set of 
classes whose relationship between them 

is best represented by the following ven 
diagram.

		  A represents doctors, B represents piano 
players, C represents writers and D 
represents singers. Which statement is 
most appropriate ?

	 	
		  (A)	 All singers are doctors.
		  (B)	 All writers and pianists are doctors.
		  (C)	 All pianists are singers.
		  (D)	 None of the above.
72.		 In the following questions below are 

given some statements followed by some 
conclusions based on those statements. 
Taking the given statements to be true 
even if they seem to be at variance from 
commonly known facts. Read all the 
conclusions and then decide which of the 
given conclusion(s) logically follows the 
given statements.

			  Statements :
		  All eyes are noses.
		  Some noses are lips.
		  Conclusions :
		  I. Some noses are eyes.
		  II. All lips are noses.
		  (A)	 Both the conclusions follow	
		  (B)	 Neither conclusion I nor II follows
		  (C)	 Only conclusions I follows	
		  (D)	 Only conclusions II follows
73.		 John bought a puppy on Friday, 21 

January, 2022. The puppy become an 
adult dog on the 380th day since John 
bought him. On which day did the puppy 
become an adult ?

		  (A)	 Sunday	 (B)	 Monday
		  (C)	 Saturday	 (D)	Wednesday
74.	 P, Q, R, S, T, U and V are sitting around 

a circular table facing the centre. U sits 
to the immediate right of T. Only three 
people sit between U and V when counted 
from the left of U. Only three people sit 
between T and R. Q sits to the immediate 
right of P. How many people sit between 
T and P when counted from the left of P ?

		  (A)	 2	 (B)	 4
		  (C)	 3	 (D)	 1
75.	 ‘#’ means ‘>’,
		  ‘$’ means ‘>’,
		  ‘%’ means ‘<’, and
		  ‘@’ means ‘<’.
		  Assuming the following statements to be 

true, which of the conclusions given in 
the options is definitely true.

		  B $ D $ A
		  R % D % L @ J

	 	 (A)	 J % D	 (B)	A % L
	 	 (C)	 B $ J	 (D)	B # L
76.	 Six people P, Q, R,S, T and U live on 

six different floors of the same building- 
The bottom-most floor of the building 
is numbered as 1; the floor above it is 
numbered as 2 and so on- The topmost 
floor is numbered as 6-
P lives on an even-numbered floor but 
not on floor number 4. Only two people 
live between S and P. R lives immediately 
below T. U lives on an even-numbered 
floor. Q does not live on the bottom-most 
floor. How many people live between Q 
and S ?

		  (A)	 Three	 (B)	 Four
		  (C)	 One	 (D)	 Two

77.	 Select the option that is related to the 
third figure in the same way as the second 
figure is related to the first figure.

 
: : : : ?

		  (A)	 	 (B)	

		  (C)	 	(D)	

78.	 Choose the correct figure that replaces the 
question mark.

		  		Problem Figures

	
	 	 Answer Figures

	
	           1                2                3               4
		  (A)	 4	 (B)	 3
		  (C)	 2	 (D)	1
79.	 Choose the figure which is different from 

the rest.

		

(A)	

	

(B)	

		

(C)	

	

(D)	
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80.	 Consider the given statement as true and 
decide which of the given conclusions 
can definitely be drawn from the given 
statements.

		  		Statements :
		  		Some actors are businessmen.
		  		All businessmen are intelligent.
		  		Conclusions :
		  		I.	 All actors are intelligent.
		  		II.	 All businessmen are actors.
		  (A)	 Only conclusion II follows
		  (B)	 Neither I nor II follows
		  (C)	 Only conclusion I follows
		  (D)	 Both I and II follow

English
Direction (Q. No. 81 to 85)

Read the passages carefully and choose the 
best answer to each question. Out of the four 
alternatives.

Earth Day is an apt moment to consider how 
our planet, a majestic 4.54 billion years old, 
is faring. The statistics are not pleasing. Once 
covered in verdant green, FAO finds Earth 
has now lost one-third of its forests through 
human activity. WWF estimates such land-use 
changes have caused wildlife to decline by 
69% in the last 50 years. The loss of natural 
ecosystems and their engineers, which includes 
birds, animals, insects and fungi, is literally 
drying up the world. The UN finds 75% of 
Earth's land is degraded while its oceans are 
30% more acidic now, choked by plastic and 
chemical waste. Neither is the air pristine - as 
pollutants coat the skies, the World Economic 
Forum finds global CO2 emissions rose in 
2022 to a record high. Such CO2 covers Earth 
in a sheath which doesn't let it release heat into 
space, trapping this in the atmosphere instead, 
making Earth 1.11 degrees warmer.

81.	 Select the most appropriate title for the 
given passage.

		  (A)	 Nature and Animals
		  (B)	 Earth and its Dangers
		  (C)	 Earth and Nature
		  (D)	 Animals and Birds

82.	 Select the tone of the passage.
		  (A)	 Cautionary	 (B)	 Entertaining
		  (C)	 Narrative	 (D)	 Persuasive

83.	 Who caused the loss of forests?
		  (A)	 Realtors	 (B)	 People
		  (C)	 Nature	 (D)	 Animals

84.	 Who are the engineers NOT mentioned 
in the passage?

		  (A)	 Eggs	 (B)	 Insects
		  (C)	 Fungi	 (D)	 Birds

85.	 Select the most appropriate ANTONYM 
of the word 'decline'.

		  (A)	 Drag	 (B)	 Decrease
		  (C)	 Push	 (D)	 Increase 

86.	 Given below a sentence. Identify the 
part of speech of the underlined word. 
Choose the response (A), (B), (C) or (D) 
which is the most appropriate expression. 
He thought the movie ended abruptly.

		  (A)	 Noun	 (B)	 Adverb
		  (C)	 Verb	 (D)	 Adjective

87.	 Change the voices of these sentences.
		  Who did this mischief ?
		  (A)	 By whom was this mischief done ?
		  (B)	 Who was this mischief done by ?
		  (C)	 Was this mischief done by you ?
		  (D)	 By whom is this mischief done ?

88.	 Choose the option which is the correct 
indirect form of the given sentence.

	 	 The traffic policeman said to the driver, 
“Why did you not stop when the traffic 
light was red ?”

		  (A)	 The traffic policeman asked the 
driver why he has not stopped when 
the traffic light was red.

	 	 (B)	 The traffic policeman asked the driv-
er why you had not stopped when the 
traffic light was red.

	 	 (C)	 The traffic policeman asked the driv-
er if he had stopped when the traffic 
light was red.

	 	 (D)	 The traffic policeman asked the driv-
er why he had not stopped when the 
traffic light was red.

89.	 Choose the word that means the same as 
the given word.

		  		Ardent
		  		(A)	 Lovable	 (B)	 Passionate
		  (C)	 Withdrawn	 (D)	Denture

90.	 Find out which part of a sentence (A), (B) 
or (C) has an error. If there is no error your 
answer is (D)

		  Each of these girls (A) / play (B) / games. 
(C) / No error (D)

¥gnh

funsZ'k (iz'u la[;k 91 ls 95 rd)

fuEufyf[kr x|ka'k dks /;kuiwoZd if<+, rFkk ml 
ij vk/kkfjr iz'uksa ds mÙkj pqfu, &

/kjkry ls ;q¼ dh foHkhf"kdkvksa dks lnk-lnk ds fy, 
lekIr djus ds fy, xk¡èkhth us fo'o dks vfgalk :ih 
vL= iznku fd;kA xk¡èkhth dgk djrs Fks fd izse vkSj 
vfgalk ds }kjk fo'o ds dBksj ls dBksj ân; dks Hkh 
dksey cuk;k tk ldrk gSA mUgksaus bu fl¼kUrksa dk 
ijh{k.k Hkh fd;k vkSj os ^furkUr* lQy fl¼ gq,A 
fgalk ls fgalk c<+rh gS] ^?k`.kk*] ?k`.kk dks tUe nsrh gS] 
vkSj izse ls izse dh vfHko`f¼ gksrh gSA vr% ;g fuf'pr 
gS] fd fcuk izse vkSj vfgalk ds fo'o esa 'kkfUr LFkkfir 
ugha gks ldrhA 'kkfUr ds vHkko esa ekuo tkfr dk 
fodkl lEHko ughaA izR;sd jk"Vª dk Lof.kZe-;qx ogh 

dgk tkrk gS] tcfd ogk¡ iw.kZ 'kkafr vkSj lq[k jgk gks 
rFkk mÙkeksÙke jpukRed dk;Z fd, tkrs gksaA HkkSfrd 
n`f"V ls O;kikj vkSj Ïf"k dh mékfr Hkh 'kkafrdky esa 
gh lEHko gksrh gS] vr% ge ;fn fo'o dk dY;k.k 
pkgrs gSa] rks gesa ;q¼ dk cfg"dkj djuk gh gksxkA 
vfgalk vkSj izse dh Hkkouk ls fo'o esa 'kkfUr LFkkfir 
djuh gksxh] rHkh fo'o esa lq[ke; ,oa 'kkafre; jkT; 
dh LFkkiuk lEHko gksxhA

91.	 fo'o 'kkafr dh LFkkiuk ds fy, lcls vko';d 
gSµ

		  (A)	 ifjJe vkSj Kku
	 	 (B)	 vkReh;rk vkSj lehirk
		  (C)	 vfgalk vkSj izse	
	 	 (D)	 fgalk vkSj Hk;

92.	 dBksj ls dBksj ân; dks Hkh dksey cuk;k tk 
ldrk gSµ

		  (A)	 Hk; }kjk	 (B)	 vfgalk }kjk
		  (C)	 ekSu ikyu }kjk	 (D)	lR; ikyu }kjk

93.	 fdlh Hkh jk"Vª ds Lof.kZe-;qx ds izeq[k rÙo gSaµ
		  (A)	 'kkfUr] lq[k vkSj jpukRed dk;Z
	 	 (B)	 vk/;kRe vkSj mikluk
		  (C)	 /ku vkSj lEeku
	 	 (D)	 /ku vkSj oSHko

94.	 ^furkUr* 'kCn dk mi;qDr i;kZ; gSµ
		  (A)	 fuEu	 (B)	 fof/kor~
		  (C)	 fcydqy	 (D)	 HkyhHkk¡fr

95.	 fo'o esa 'kkafr D;ksa vko';d gS\
		  (A)	 dBksj ls dBksj ân; dks Hkh dksey cukus 

ds fy,
	 	 (B)	 O;kikj vkSj Ïf"k dh mékfr ds fy,
		  (C)	 mÙkeksÙke jpukRed dk;Z ds fy,
	 	 (D)	 ekuo tkfr ds fodkl ds fy,

96.	 ^vR;kpkj* dk lgh laf/k-foPNsn gS %
		  (A)	 vfr;k $ pkj	 (B)	 vr~ $ vkpkj
		  (C)	 vfr $ vkpkj	 (D)	vR;k $ pkj

97.	 L=h¥yx-iqfYyax dk dkSu-lk tksM+k lgh ugha gS\
		  (A)	nso-nsoh	 (B)	ekek-ekeh
		  (C)	dkUr-dkUrh	 (D)	xèkk-xèkh

98.	 fuEufyf[kr rRle-rn~Hko 'kCnksa dk laxr 
;qXe gSµ

		  (A)	 [kiZV - [kksiM+h	 (B)	 läq - lR;

		  (C)	 i;±d - iyax	 (D)	 ?kksVd - ?kM+k

99.	 fuEufyf[kr esa ls dkSu&lk 'kCn ^dey* dk 
i;kZ;okph ugha gS \

		  (A)	 uhjt	 (B)	 mRiy
		  (C)	 vjfoUn	 (D)	okfjn

100.	 ^mFkyk* 'kCn dk foykse gSµ
		  (A)	xgjk	 (B)	 fNNyk

		  (C)	 lery	 (D)	mHkkj
qq
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